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DRM Lite in Edge 
DRM Lite is an electronic delivery method that allows the British Library to deliver documents 

securely. When a document is requested via this service the document is locked so that only one 

user can access it, so you will have to register to use the service. This is separate from the 

registration process to submit interlibrary loan requests to University of Portsmouth Library. 

The DRM Lite service has several advantages: there is no need to download any plugins, which can 

cause problems on University of Portsmouth computers, and the document is not tied to one 

computer. The document can be downloaded for up to 30 days after receiving notification of its 

arrival and, if saved, can be accessed for up to 3 years. It can also be printed to keep for ever. 

 

Contents 
Click on the links below to go to the relevant section. 

Registering for British Library On Demand 

Opening a document 

Saving and printing 

Troubleshooting 

 

If you are using a different browser or a mobile device, other Library Guides are available.  
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Registering for British Library On Demand 
 

The Library recommends registering with British Library On Demand before placing an interlibrary 

loan request so that when your document arrives you can just get on with reading it. It only takes a 

few minutes. 

1. Go to https://ondemand.bl.uk/onDemand/home and click on Register: 

 

 

2. On the next screen, click on Register: 

 

  

Ignore the top section. 

https://ondemand.bl.uk/onDemand/home
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3. Enter your details and click on Register: 

 

 

 

4. There may be a short wait with the message “Preparing your registration”. You will then see this 

screen: 

 

When you click OK, it takes you to the British Library On Demand home page. 

Create your own 

username and password 

and make a note of 

them. We recommend 

using your University 

login, but this may not 

be compatible with the 

security requirements: 

 Username: at least 6 

characters (avoid the @ 

symbol) 

 Password: 8-20 

characters, including 

capital, lower case, and 

number. 

 

Use your University 

address and email 

address. 
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5. Go to the email account that you registered with. You will have an email from the British Library; 

click on the link to activate your account: 

 

 

 

6. Activate your account by entering your username and password: 

 

 

This is the 

username and 

password you 

created earlier. 

(Probably the 

same as your 

University login.) 
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7. You will be asked for some additional information.

 

Only the starred fields are mandatory. 

  

Use your University 

address. 

 

 

 

 

Delivery address doesn’t 

matter – delivery will be to 

your email address. 

 

Only one phone number is 

needed. 

 

Additional information is 

not required. 
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8. Accept the terms and conditions: 

 

 

9. There may be a short wait while your registration is completed. You are then taken back to the On 

Demand home page: 

 

 

10. You will also receive an email confirming your registration: 

 

 

11. You should wait 5 minutes after registering before attempting to download any documents. 

  

 

There is no need 

to associate your 

account with our 

Business Account. 
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Opening a document in Edge 
Documents ordered via the Interlibrary Loans Service are usually delivered electronically from the 

British Library. Once you have registered for a British Library On Demand account, follow the 

instructions below to open your document. 

1. You will receive an email from the British Library when your document is available. Google Mail 

may see this as spam, so check your spam and junk folders. Click on the link to your document: 

 

2. You will be taken to a web page where you can download your document: 

 

3. You must open the document with Adobe Reader or Adobe Acrobat. On many computers this 

will happen automatically, but if you have a different default PDF reader, you will have to find the 

folder where your document has downloaded and select Open with… 

If you haven’t registered yet, 

you can do so here. 

The instructions below explain 

how to open the document 

with Adobe Reader. 

 

Enter the username or email 

address that you used when 

you registered. You don’t 

need to put both separated by 

a slash. Click on Download 

your document. 
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In Edge a bar appears at the bottom of the screen.  

 

You may be able to just click on Open. If this works, go to step 4. 

If this doesn’t work, click on Save. 

The text in the bar changes: 

 

Click on Open folder. 

Your Downloads folder opens up with the document highlighted: 

 

 Right click on the document 

 Select Open with… 

 Select Adobe Acrobat Reader DC 

4. Adobe Reader opens up and you get a login box. Enter your British Library On Demand username 

and password: 

 

 

  

 

This is the 

username and 

password you 

created when 

you registered. 
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5. You may be asked if you want to view secure documents offline: 

 

If you are not sure, click No. 

 

6. The document opens: 
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7. If you go back to the original page with the button to download your document, it is now locked 

to the person who logged in. No-one else can access the document, but you will be able to open it 

on other machines. 
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Saving and printing in Edge 
Once you have opened your DRM Lite document, we recommend saving or printing it to ensure 

continued access. 

 You have 30 days to download your document from the day you receive the email. 

 After 30 days the document is deleted from the British Library’s servers, so the link in the 

email will no longer work. 

 If you want access after this, you must save or print the document. 

The document opens in Adobe Reader. 

 

The usual save command in Adobe Reader is disabled for these secure documents; you can see in 

the image above that the icon is greyed out. There are a few options to save it. 

Option 1 
On some machines, in Adobe Reader you can go to the File menu, then select PDF. Save the 

document as you would normally. 

This is not available on all computers. 

Option 2 
In Edge the document is automatically saved in your Downloads folder. You can choose to leave it 

there if you think you will be able to find it in future. 
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Option 3 
You may prefer to move your document to somewhere easier to find it in future (e.g. My Documents 

or a memory stick). 

Firstly, find where your document has been downloaded to. 

In Edge, click the hub icon in the top right and select the downloads icon. Then click on Open folder.

 

 

This opens a Windows Explorer window: 

 

 

To move the document, copy and paste: 

 Right click on the document 

 Copy it 

 Go to the folder you want to save to 

 Paste the document into that folder 
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Alternatively drag and drop the document into a location in your Favorites: 

 

 

Saving and printing limits 
 Once saved, the document is accessible for 3 years. You can access it from any machine with 

internet access: navigate to the drive where you saved the document and enter your 

username and password. 

 You can only print the document once. 

 We recommend saving and/or printing as soon as possible to ensure that you don’t lose it. 

 You may forward the link to the document to another email address before you open it for 

the first time, but only one person may download the document. 
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DRM Lite troubleshooting 
 

Initial questions 
If you are having problems with DRM Lite, it is helpful to Library staff to know the basics of what you 

are trying to do and your computer set-up. 

1. What stage have you got to? What are you trying to do? 

 Have you registered for British Library On Demand? (N.B. this is different from 

registering for the system to request an interlibrary loan; British Library On Demand 

allows clients to open secure electronic documents.) 

 Trying to open/download a document by clicking on the link in the email from British 

Library 

 Trying to save a document 

 Trying to open a saved document 

 Trying to print a document 

 

2. Which browser are you using? 

 

3. Is it a standard Windows PC?  

 MAC/Linux? 

 Tablet/mobile device? 

 On campus or off campus? 

 Do you have an old version of Adobe Reader? 

 

4. Is there an error message? 

 Get a screenshot if you can or find the exact error message. Search for the error 

message below. 
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Common issues 

I forgot my username or password 
If you have forgotten your username or password for British Library On Demand, go to 

https://ondemand.bl.uk/onDemand/login/auth?currentPage=home and click on Forgotten 

Username or Password? 

 

To change your password, log in at https://ondemand.bl.uk/onDemand/home.  Go to View/Update 

My Account Details, and enter your login again. Under the My Settings tab, you can change your 

password. 

 

You must use Adobe Reader or Adobe Acrobat to open the document 
If your computer is set up to use a different default pdf reader, such as your browser’s pdf viewer, 

Foxit or Corel, it will not work. See the instructions on opening documents for your device. 

 

You must be connected to the internet 
Even if you have saved a document offline, you must be connected to the internet to open it. 

 

The download link has expired 
You have 30 days from when the email is sent by the British Library to open and save or print the 

document. If you do not save or print the document, the link in the email will stop working after 30 

days as the document is removed from the British Library’s servers. 

 

Emails in spam 
Some emails from the British Library are interpreted as spam. If you think you should have received 

your document, check your spam and junk folders. 

 

Delay after registering 
If you have just registered for British Library On Demand, you should wait for 5 minutes before 

attempting to download your document. If you get an error message, British Library may need to re-

send the document to you.  

https://ondemand.bl.uk/onDemand/login/auth?currentPage=home
https://ondemand.bl.uk/onDemand/home
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Problems with downloading documents 
 

There was a problem accessing your document, please try again later 

 

Have you just registered for British Library On Demand in the last few minutes? There is a short 

delay between registering and being able to view your document.  

Solution: Wait for 5-10 minutes and try again. 

 

Does your username contain the @ symbol? 

Solution: contact British Library Customer Services for advice. 

 

This also happens when the link to the document has expired. You have 30 days from when the 

email is sent by the British Library to open and save or print the document. If you do not save or 

print the document, the link in the email will stop working after 30 days as the document is removed 

from the British Library’s servers. If you still need the document, you will have to submit another 

request and we will have to pay for it again. 

  

http://www.bl.uk/aboutus/contact/
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Failed to load PDF document 

 

 

Are you using Chrome? The document has tried to open in Chrome’s built-in PDF reader. 

Solution 1: Instead of just opening the document, go to your Chrome downloads folder and open 

with Adobe Reader (see the instructions above). 

Solution 2: Disable the Chrome PDF reader: 

 In the address bar type: chrome://settings/content 

 Scroll down to PDF documents 

 Tick Open PDF files in the default PDF viewer application 
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Couldn’t open PDF or PDF error 

 

 

The document has tried to open using the Edge browser’s built-in PDF reader. This may happen even 

if you are using another browser, as Edge is the default PDF reader on campus. 

Solution 1: Instead of just opening the document, go to your downloads folder and open with Adobe 

Reader (see the instructions above). 

Solution 2: Disable the Edge PDF reader: 

 Go the Start menu 

 Go to Settings 

 Select Apps 

 Select Default apps 

 Choose default applications by file type 

 For .pdf files, select Adobe Acrobat Reader DC 
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Corel PDF Fusion was unable to read document 

 

Corel may be set as your default PDF viewer. Solution: Instead of just opening the document, go to 

your downloads folder and open with Adobe Reader (see instructions above). 
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Cannot display PDF… pdf is of invalid format 

Are you using an Android device? When you click on Download your document, the device tries to 

open the document in Chrome and this message flashes up briefly. This will not work as you have to 

open it with Adobe Acrobat Reader. 

Solution: go to your Downloads app. Find your document, tap on it, and select Open with Adobe 

Acrobat. 
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The account information you entered is incorrect. Please try again. 

 

This comes up when you are trying to open the document and enter the wrong username or 

password. 

 

Solution: If you can’t remember your username or password for British Library On Demand, go to 

https://ondemand.bl.uk/onDemand/login/auth?currentPage=home and click on Forgotten 

Username or Password? 

 

  

https://ondemand.bl.uk/onDemand/login/auth?currentPage=home
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User name entered not found, please retry 

I have forgotten my username or password 

 

1. Where you are asked to enter your On Demand username or email address, this could be 

interpreted as needing both separated by a slash, as in the screenshot above. You only need to enter 

your username or email address, not both, e.g.: 

Username: leonperry 

Or 

Email address: leon.perry@port.ac.uk 

 

2. Check you have spelled it correctly. 

 

3. Are you using your login for British Library On Demand? This is not necessarily the same as the 

login you use to request interlibrary loans. 

 

4. If you can’t remember your username or password for British Library On Demand, go to 

https://ondemand.bl.uk/onDemand/login/auth?currentPage=home and click on Forgotten 

Username or Password? 

mailto:leon.perry@port.ac.uk
https://ondemand.bl.uk/onDemand/login/auth?currentPage=home


  Last updated: 16th October 2019 
 

23 
 

End User supplied in Order not found 

You may be clicking on Download your document without having registered. Make sure you have 

registered for a British Library On Demand account.  
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Access to this document is restricted. Your account does not have permission to open it. 

 

1. If you have changed your password, or if you are on a shared computer or device, a previous user 

may have locked you out by selecting “Remember me on this computer”. If so: 

 In Adobe Reader go to Edit > Preferences > Security. 

 Click Clear remembered account information and confirm. 

 Retry the download link. 

 

 

 

2. If you just registered for a British Library On Demand account and tried to download the 

document within 5 minutes, the download will fail. Contact British Library Customer Services and ask 

them to re-send the document. You will need the reference number (e.g. ED01234). 
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This computer must be connected to the network in order to open this document. 

 

This occurs because Adobe no longer support old versions of Transport Layer Security. 

Step 1: make sure you have the most up-to-date version of Adobe Reader. We recommend version 

DC. 

If you need to upgrade, 

 On campus, go to AppsAnywhere and launch Adobe Acrobat DC, or go to the Microsoft 

System Center from the Start menu. 

 Off campus, you can download the latest version for free from 

https://get.adobe.com/uk/reader 

 For mobile devices, visit the app store. 

When you open the document from the British Library, make sure you select Open with > Adobe 

Reader DC. Do not open with older versions such as X or XI. 

 

Step 2: enable TLS 1.2 

If updating your version of Adobe Reader doesn’t help, you may need to enable a new version of 

Transport Layer Security (TLS) on your computer. To enable TLS 1.2, follow these instructions, 

depending on the browser you are using.  

 

 

  

https://get.adobe.com/uk/reader
https://knowledge.digicert.com/generalinformation/INFO3299.html
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Other issues with downloading 

Are you connected to the internet? 
Even when you have saved a document, you still need online access every time you open it. 

 

Do you have Adobe Reader installed? Which version of Adobe Reader do you have? 

 You must have Adobe Reader 10 or above. We recommend version DC. 

 Adobe Acrobat Reader is also fine. Adobe Reader is just for reading PDFs; Acrobat also lets 

you edit and create PDFs. 

 

Everyone on campus should have the correct software installed automatically. However, it may not 

be set up as the default PDF reader, so make sure you open with Adobe Reader. 

 

How to tell if you have Adobe Reader installed: 

 Go to Start > All Programs 

 If you have it, it should be listed here. 

 

How to tell which version you have. 

 Open Adobe Reader. 

 Go to Help > About Adobe Reader 

 

How to get Adobe Reader 

Everyone on campus should have one of Adobe Reader XI or Adobe Acrobat Reader DC installed. If 

not, go to AppsAnywhere (on your desktop) or the Software Centre (Start > All Programs > Microsoft 

System Center > Software Center). 

 

Off campus, you can download Adobe Acrobat Reader for free from: 

https://get.adobe.com/uk/reader/ 

 

Do you have an unusual computer set-up? 
Linux operating system: does not work 

Windows phone: does not work 

 

Macs (including MACBooks, iPads and iPhones): should all be OK. The device may try to view the PDF 

in Preview, in which case you will just see blank pages. You must force the device to open the 

document with the Adobe Reader app. 

 

Android mobile device (tablet or phone) 

This should work. See the separate instructions for downloading and saving on Android mobile 

devices. 

Apple mobile device (iPad, iPhone, iPod Touch) 

This should work. See the separate instructions for downloading and saving on Apple mobile devices. 

 

 

https://get.adobe.com/uk/reader/
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If you are having problems, try downloading your document on a standard Windows PC on campus, 

which should have all the necessary software installed. 

 

I haven’t received the email with the link to the document 
If our records or the British Library’s records show that the email has been delivered, check in the 

spam and junk folders. Some clients have found the email there. 

If it does go to spam, mark the email as “not spam” to reduce problems in future. 

 

For documents delivered before 7th June 2017 
If you are trying to access a saved document that was delivered before 7th June 2017, you will need 

to use FileOpen software as you did before. These DRM Lite instructions will not apply to older 

documents. Saved FileOpen documents will be accessible for 3 years.  
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Problems with registering for British Library On Demand 
See the full instructions on registering for how the process should work. This section focuses on the 

main potential problems. 

There are several stages: 

1. Form with personal details. Make up your own username and password. 

2. You get an email from British Library. Click on the link to activate your account. 

3. Fill in another form with more details. 

Stage 1: enter personal details. 
The starred fields are mandatory. 

If you click on Register but nothing happens, check to see if there is missing information or if any 

fields have red crosses next to them: 

 

Username and password: we recommend using your UoP email address and network login details as 

this makes it easy to remember, but this may not fit with the British Library’s requirements. 
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Click in the box next to the red cross for an explanation of what the problem is.  

For example, username has failed: 

 

 

Here the password is not secure enough: 

 

 

Make sure you tick to accept the terms and conditions. 

 

 

When you click on Register, there may be a wait with the message Preparing your registration. If this 

has not cleared after a minute, check there are no red crosses indicating fields filled in incorrectly. 

 

Stage 2: activate account 
Client should get an email headed British Library Online Account Activation.  

Click on the link in the email. 

 



  Last updated: 16th October 2019 
 

30 
 

Stage 3: customise account 

 

The address and phone number are not very important for University students and staff; this form is 

also aimed at individuals who are not affiliated to organisations. If you’re not sure what to put, use 

your University contact details. 

Delivery address: this is irrelevant as documents will be delivered electronically. 

There may be a wait while your registration is completed. When everything is finished, you get an 

email headed British Library Service Registration Complete.  
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The email suggests associating your account with the University’s Business Account. There is no need 

to do this. 

 

Contact us 
If you have any problems with retrieving your documents via this service, please contact the Library: 

http://www.libr.port.ac.uk/help/ 

For any problems related to your British Library On Demand account, e.g. problems logging in, 

contact British Library Customer Services. 

 

 

 

http://www.libr.port.ac.uk/help/
https://www.bl.uk/about-us/contact-us

